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Skills for Success with Microsoft Office 2010 Volume 1, 2e (Townsend) 

Word Chapter 2:  Format and Organize Text 

Chapter Questions 

1) The spaces between the text and the top, bottom, left, and right edges of the paper are the 

________. 

A) indents. 

B) justifications. 

C) margins. 

D) alignments. 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

2) The Margins button is found on the ________ group under the Page Layout tab. 

A) Page Background 

B) Theme 

C) Page Setup 

D) Paragraph 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

3) Margins can be set by either typing in the desired value or using the ________. 

A) align menu. 

B) spin arrows. 

C) vertical scroll bar. 

D) horizontal scroll bar. 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

4) A document printed using ________ orientation is taller than it is wide. 

A) landscape 

B) portrait 

C) paragraph 

D) justified 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 
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5) Using ________ orientation causes the document to have a page width greater than its page 

height. 

A) landscape 

B) portrait 

C) paragraph 

D) justified 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

6) ________ are the positions of paragraph lines in relation to the page margin. 

A) Alignments 

B) Justifications 

C) Line spacings 

D) Indents 

Answer:  D 

Diff: 1 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

7) The orientation of the left or right edges of the paragraph, in relation to the left or right margin 

is called: 

A) landscape orientation. 

B) portrait orientation. 

C) horizontal alignment. 

D) spacing. 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

8) Paragraphs who have their text aligned flush with both the left and right margin are said to be 

________. 

A) centered. 

B) spaced. 

C) justified. 

D) aligned right. 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

9) The ________ is the location of the beginning of the first line of the paragraph in relationship 

with the left edge of the remainder of the paragraph. 

A) top line justification 

B) first line justification 

C) paragraph justification 

D) first line indent 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 
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10) The vertical distance between lines of text in a paragraph is called: 

A) line spacing. 

B) paragraph spacing. 

C) indention. 

D) justification. 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

11) ________ spacing is the vertical distance above and below each paragraph. 

A) Line 

B) Paragraph 

C) Indention 

D) Justification 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

12) Inserting a(n) ________ break into a paragraph moves the remainder of the paragraph to the 

next line while keeping both lines in the current paragraph. 

A) manual paragraph 

B) manual page 

C) automatic page 

D) manual line 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

13) To insert a manual line break, you press: 

A) [SHIFT] + [ENTER] 

B) [CTRL] + [ENTER] 

C) [SHIFT] + [CTRL] 

D) [ALT] + [ENTER] 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

14) A manual page break is inserted into the document by pressing: 

A) [SHIFT] + [ENTER] 

B) [CTRL] + [ENTER] 

C) [SHIFT] + [CTRL] 

D) [ALT] + [ENTER] 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 
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15) Inserting a ________ break moves the text that follows it to the next page. 

A) manual paragraph break 

B) manual page 

C) manual line 

D) justification 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

16) Double-spacing is accomplished by setting line spacing to: 

A) 1.0 

B) 1.5 

C) 2.0 

D) 4.0 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

17) ________ means that no extra space is added between lines of text. 

A) Justification 

B) Indentation 

C) Single-spacing 

D) Double-spacing 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

18) The ________ can be used to quickly copy formatting from one place to another. 

A) Find and Replace button 

B) Copy and Paste button 

C) Text Painter 

D) Format Painter 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 

19) On the Home tab, the Format Painter is found under the ________ group. 

A) Font 

B) Paragraph 

C) Editing 

D) Clipboard 

Answer:  D 

Diff: 3 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 
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20) The Find button is found in the ________ group, under the Home tab. 

A) Font 

B) Paragraph 

C) Editing 

D) Clipboard 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

21) The results of doing a Find are displayed in the ________. 

A) Find Pane 

B) Review Pane 

C) Locate Pane 

D) Navigation Pane 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

22) The ________ command is used to quickly locate a word or phrase within a document. 

A) Find 

B) Locate 

C) Look 

D) Scan 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

23) The ________ command allows the user to find, and then substitute, word or phrases within 

the document. 

A) Search 

B) Replace 

C) Substitute 

D) Scan 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

24) When using Find, you type the word or phrase you are trying to find into the ________. 

A) Navigation Pane Search box 

B) Open dialog box 

C) Locate Pane dialog box 

D) Clipboard 

Answer:  A 

Diff: 3 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 
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25) You use the ________ to peruse the Navigation pane and view the results of the Find 

command. 

A) vertical scroll bar 

B) horizontal scroll bar 

C) down spin arrow 

D) up spin arrow 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

26) A ________ list is a list of items with each term introduced by a symbol. 

A) sorted 

B) numbered 

C) bulleted 

D) justified 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

27) A ________ list is a list of items introduced in a way to indicate definite steps, a sequence of 

actions, or chronological order. 

A) sorted 

B) numbered 

C) bulleted 

D) justified 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

28) The Bullets button is found under the ________ group on the Home tab. 

A) Paragraph 

B) Styles 

C) Editing 

D) Clipboard 

Answer:  A 

Diff: 3 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

29) If you want the date and time placed in a header or footer to be updated every time the 

document is opened, you must make sure the ________ check box is on. 

A) Set clock 

B) Update clock 

C) Update Calendar 

D) Update automatically 

Answer:  D 

Diff: 3 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 
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30) The Headers & Footers group is found on the ________ tab of the Ribbon. 

A) Page Layout 

B) Home 

C) Insert 

D) References 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 

31) A(n) ________ is a reference placed at the bottom of the page. 

A) endnote 

B) footnote 

C) citation 

D) bibliography 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

32) A(n) ________ is a reference placed at the end of a section or a document. 

A) endnote 

B) footnote 

C) citation 

D) bibliography 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

33) The Footnotes group is located under the ________ tab of the Ribbon. 

A) Insert 

B) References 

C) Review 

D) Page Layout 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

34) A(n) ________ is a note in the document that refers the reader to a source in the 

bibliography. 

A) report 

B) bulletin 

C) citation 

D) endnote 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 2, Skill 9: Add Citations 
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35) A(n) ________ is a list of sources referenced in a report, and is listed on a separate page at 

the end of the report. 

A) citation 

B) footnote 

C) endnote 

D) bibliography 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

36) A ________ indent is where the first line of the paragraph extends to the left of the rest of the 

paragraph. 

A) hanging 

B) justified 

C) landscape 

D) portrait 

Answer:  A 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

37) The Citations and Bibliographies group is found under the Ribbon's ________ tab. 

A) Page Layout 

B) References 

C) Insert 

D) File 

Answer:  B 

Diff: 3 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

38) The Word feature ________ would automatically correct the word entered as teh to the. 

A) Spell Check 

B) AutoCorrect 

C) AutoFix 

D) AutoFormat 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, More Skills 11: Record AutoCorrect Entries 

39) ________ can be used to create shortcuts for commonly used phrases. 

A) Spell check 

B) Grammar check 

C) Live Preview 

D) AutoCorrect 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, More Skills 11: Record AutoCorrect Entries 
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40) The ________ feature in Word allows you to start typing a numbered list and the program 

will automatically add numbers and formatting to the list as you type. 

A) Live Preview 

B) Print Preview 

C) List Preview 

D) AutoFormat 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, More Skills 12: Use AutoFormat to Create Numbered Lists 

41) Choosing ________ from the shortcut menu allows the user to have a second list, separated 

by text from the first list, pick up the numbering of the first list. 

A) More Numbers 

B) Increase Numbering 

C) Continue Numbering 

D) Additional Numbering 

Answer:  C 

Diff: 3 

Skill:  Word Chapter 2, More Skills 13: Format and Customize Lists 

42) If you increase the indentation of an item in a list, you move it to another ________. 

A) column. 

B) row. 

C) tier. 

D) level. 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, More Skills 13: Format and Customize Lists 

43) Information about a document such as the name of the document author, the file name, and 

key-words are called document ________. 

A) memos. 

B) notes. 

C) properties. 

D) citations. 

Answer:  C 

Diff: 2 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 

44) You add properties, or property information, and view or update existing document 

properties in the ________. 

A) Permissions area 

B) Save As dialog box 

C) Open dialog box 

D) Document Information Panel 

Answer:  D 

Diff: 2 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 



Skills for Success with Office 2010 Vol. 1, 2e
 

Page 10 of 21 

45) Document properties are displayed on the ________ page of the Backstage view. 

A) Share 

B) Info 

C) Help 

D) Print 

Answer:  B 

Diff: 2 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 

46) The spaces between text and the top, bottom, left, and right edges of the paper are called 

________. 

Answer:  margins 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

47) Documents printed using ________ orientation are taller than they are wide. 

Answer:  portrait 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

48) The page orientation in which the page width is greater than the page height is called 

________. 

Answer:  landscape 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

49) A(n) ________ is the position of a paragraph line in relation to the page margin. 

Answer:  indent 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

50) A paragraph's ________ alignment is the orientation of the left and right edges of the 

paragraph to the margins. 

Answer:  horizontal 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

51) If the text of a paragraph is aligned flush with both the left and right margins, the paragraph 

is said to be ________. 

Answer:  justified 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

52) The first line ________ is the location of the beginning of the first line of the paragraph in 

relationship with the left edge of the rest of the paragraph. 

Answer:  indent 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 
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53) The vertical distance between lines in a paragraph is called ________ spacing. 

Answer:  line 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

54) The vertical distance above and below each paragraph is called ________ spacing. 

Answer:  paragraph 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

55) If a document is typed using ________-spacing, the equivalent of a blank line of text 

displays between each line of text. 

Answer:  double 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

56) To quickly copy the text formatting from one place to another, use the ________ Painter. 

Answer:  Format 

Diff: 2 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 

57) The ________ command can be used to locate a word or phrase within a document. 

Answer:  Find 

Diff: 2 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

58) A(n) ________ list introduces each item in the list with a symbol such as a small circle or a 

check mark. 

Answer:  bulleted 

Diff: 2 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

59) A(n) ________ list is used when the items in the list represent a series of definite steps. 

Answer:  numbered 

Diff: 1 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

60) Headers and footers can contain ________, where file names and the current date can be 

shown. 

Answer:  fields 

Diff: 2 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 

61) A reference placed at the bottom of the page is called a(n) ________. 

Answer:  footnote 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 
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62) A(n) ________ is a reference placed at the end of a section or document. 

Answer:  endnote 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

63) A(n) ________ is a note in the document that refers the reader to a source in the 

bibliography. 

Answer:  citation 

Diff: 2 

Skill:  Word Chapter 2, Skill 9: Add Citations 

64) A(n) ________ is a list of sources referenced in a report and is listed on a separate page at 

the end of the report. 

Answer:  bibliography 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

65) A ________ indent is where the first line of the paragraph extends to the left of the rest of the 

paragraph. 

Answer:  hanging 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

66) The ________ Correct feature in Word corrects common spelling errors as the user types. 

Answer:  Auto 

Diff: 2 

Skill:  Word Chapter 2, More Skills 11: Record AutoCorrect Entries 

67) From the _______Correct Options menu, the user can turn automatic numbering off. 

Answer:  Auto 

Diff: 2 

Skill:  Word Chapter 2, More Skills 12: Use AutoFormat to Create Numbered Lists 

68) Increasing the ________ of a list, causes the list to move to the right. 

Answer:  indent 

Diff: 2 

Skill:  Word Chapter 2, More Skills 13: Format and Customize Lists 

69) Information about a document such as the name of the author of the document, the file name, 

and key words are examples of the document ________. 

Answer:  properties 

Diff: 2 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 
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70) The Document ________ Panel is where the user can add properties or property information 

and view and update existing document properties. 

Answer:  Information 

Diff: 2 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 

71) The left and right margins must be adjusted simultaneously. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

72) The top and bottom margins can be adjusted separately. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

73) All of the formatting options found in the Page Setup dialog box are also available on the 

Ribbon. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

74) Portrait orientation means that the printed page is wider than it is tall. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

75) To align a single paragraph, you must first use the mouse to highlight all of the words in the 

paragraph. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

76) If line spacing is set to 2.0, the equivalent of a blank line of text will appear between each 

line of text. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

77) Text with line spacing set to 1.0 is easier to read than text with line spacing set to 1.5. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

78) Text formatting can be copied quickly from one place to another using the Format Painter. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 
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79) Double-clicking on the Format Painter allows the user to use it on multiple items. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 

80) The Find command will not locate your search string if it is part of another word in the 

document. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 5: Find and Replace Text 

81) A bulleted list is the best way to indicate chronological order. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

82) Dragging text treats the text as if it had been cut and pasted. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

83) A footer can be set to show on every page of the document except the first page. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 

84) Graphics can not be placed in the header of a document. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 

85) You can insert the date and time into a document's footer and have the date and time updated 

every time the document is opened. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 7: Insert and Format Headers and Footers 

86) When a footnote is entered into a document, a line is automatically inserted to separate the 

footnote area from the document text. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

87) Footnotes are placed in a section at the end of the document. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 
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88) The Footnote and Endnote dialog box provides a way for the user to change footnotes to 

endnotes. 

Answer:  TRUE 

Diff: 3 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

89) Footnotes in a Word document can only be labeled with numbers. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, Skill 8: Insert and Modify Footnotes 

90) A citation is a note in the document that refers the reader to a source in the bibliography. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 2, Skill 9: Add Citations 

91) In a hanging indent, the first line of the paragraph is indented farther to the right than the rest 

of the paragraph. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

92) AutoCorrect can be used to create shortcuts for commonly used phrases. 

Answer:  TRUE 

Diff: 2 

Skill:  Word Chapter 2, More Skills 11: Record AutoCorrect Entries 

93) Existing text in a document can not be converted to a numbered list. 

Answer:  FALSE 

Diff: 2 

Skill:  Word Chapter 2, More Skills 12: Use AutoFormat to Create Numbered Lists 

94) Continuous numbering cannot continue from one list to a second list if there is other text 

between the lists. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, More Skills 13: Format and Customize Lists 

95) Document properties for all Word files on a computer are stored in one special document. 

Answer:  FALSE 

Diff: 3 

Skill:  Word Chapter 2, More Skills 14: Manage Document Properties 
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Match the following terms to their meanings: 

A) Printed page is wider than it is tall. 

B) A reference placed at the bottom of the page. 

C) Automatically adds numbers and formatting to a list as you type. 

D) Copies text formatting from one place to another. 

E) The position of paragraph lines in relation to the page margins. 

F) The equivalent of a blank line displays between each line of text. 

G) A list of items each of which are introduced by a symbol. 

H) The location of the beginning of the first line of a paragraph. 

I) Vertical distance between lines in a paragraph. 

J) Automatically discovers and replaces misspelled words with the correct words. 

K) The spaces between the text and the top, bottom, left and right edges of the paper. 

L) A break that moves the remainder of the paragraph to a new line. 

M) A list of sources referenced in a report. 

N) A note in a document that refers the reader to a source. 

O) No extra space is added between lines of text. 

P) Vertical distance above and below each paragraph 

Q) The first line of the paragraph extends to the left past the other lines of the paragraph. 

R) The vertical distance between lines in a paragraph 

S) A reference placed at the end of a section or document. 

T) Orientation of the left or right edges of the paragraph 

U) Paragraph text is aligned flush with both the left and right margins 

V) A break that moves the the text following it to a new page. 

W) Printed page is taller than it is wide. 

X) Can contain fields for file names and the current date. 

Y) A list of items each of which are introduced by a number. 

96) Footnote 

Diff: 2 

Skill: Word Chapter 2, Skill 8: Insert and Modify Footnotes 

97) Bibliography 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

98) Citation 

Diff: 2 

Skill:  Word Chapter 2, Skill 9: Add Citations 

99) Endnote 

Diff: 2 

Skill: Word Chapter 2, Skill 8: Insert and Modify Footnotes 

100) Headers and footers 

Diff: 2 

Skill: Word Chapter 2, Skill 7: Insert and Format Headers and Footers 
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101) Bulleted list 

Diff: 2 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

102) Numbered list 

Diff: 2 

Skill:  Word Chapter 2, Skill 6: Create Bulleted and Numbered Lists 

103) First line indent 

Diff: 2 

Skill: Word Chapter 2, Skill 2: Align Text and Set Indents 

104) Hanging indent 

Diff: 2 

Skill:  Word Chapter 2, Skill 10: Create Bibliographies 

105) Line spacing 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

106) Margins 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

107) Manual line break 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

108) Manual page break 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

109) Line spacing 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

110) Paragraph spacing 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

111) Format Painter 

Diff: 2 

Skill:  Word Chapter 2, Skill 4: Format Text Using Format Painter 

112) AutoFormat 

Diff: 2 

Skill:  Word Chapter 2, More Skills 12: Use AutoFormat to Create Numbered Lists 



Skills for Success with Office 2010 Vol. 1, 2e
 

Page 18 of 21 

113) AutoCorrect 

Diff: 2 

Skill:  Word Chapter 2, More Skills 11: Record AutoCorrect Entries 

114) Portrait orientation 

Diff: 1 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

115) Landscape orientation 

Diff: 2 

Skill:  Word Chapter 2, Skill 1: Set Document Margins 

116) Double-spacing 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

117) Single-spacing 

Diff: 2 

Skill:  Word Chapter 2, Skill 3: Modify Line and Paragraph Spacing 

118) Indents 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

119) Horizontal alignment 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

120) Justified 

Diff: 2 

Skill:  Word Chapter 2, Skill 2: Align Text and Set Indents 

Answers: 96) B  97) M  98) N  99) S  100) X  101) G  102) Y  103) H  104) Q  105) R  106) K 

107) L  108) V  109) I  110) P  111) D  112) C  113) J  114) W  115) A  116) F  117) O  118) E 

119) T  120) U 
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End of Chapter Questions 

1) 

___ 1. The space between the text and the top, bottom, left, and right edges of the paper when 

you print the document. 

___ 2. The position of the first line of a paragraph relative to the text in the rest of the 

paragraph. 

___ 3. The equivalent of a blank line of text displayed between each line of text in a paragraph. 

___ 4. The vertical distance above and below each paragraph in a document. 

___ 5. A command that copies formatting from one place to another. 

___ 6. The command that locates text in a document. 

___ 7. The type of list used for items that are in chronological or sequential order. 

___ 8. A reference added to the end of a section or document. 

___ 9. A list of sources displayed on a separate page at the end of a report. 

___ 10. The command used to display changes made in the Source Manager to a source listed in 

the bibliography. 

A. Bibliography 

B. Double-spacing 

C. Endnote 

D. Find 

E. First line indent 

F. Format Painter 

G. Margin 

H. Numbered 

I. Paragraph spacing 

J. Update Field 

Answer:  1. G  2. E  3. B  4. I  5. F  6. D  7. H  8. C  9. A  10. J 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

2) To create your own document margins, use this command at the bottom of the Margins 

gallery. 

A) Format Paragraph 

B) Document Settings 

C) Custom Margins 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 
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3) The placement of paragraph text relative to the left and right document margins is called 

paragraph: 

A) Alignment 

B) Margins 

C) Orientation 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

4) The vertical distance between lines in a paragraph is called: 

A) Spacing after 

B) Line spacing 

C) Text wrapping 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

5) This alignment is used to position paragraph text an equal distance between the left and right 

margin: 

A) Justify 

B) Center 

C) Middle 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

6) This type of alignment positions the text so that it is aligned with both the left and right 

margins. 

A) Justify 

B) Center 

C) Left 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

7) Hold down Ctrl + Enter to insert one of these: 

A) Manual line break 

B) Manual paragraph break 

C) Manual page break 

Answer:  C 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 
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8)  Items that can be listed in any order are best presented using which of the following? 

A) Bulleted list 

B) Numbered list 

C) Outline list 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

9) In a bibliography, this type of indent is used for each reference: 

A) Hanging indent 

B) First line indent 

C) Left alignment 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

10) To place a note on the same page as the reference source, use which of these? 

A) Footnote 

B) Endnote 

C) Citation 

Answer:  A 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 

11) This refers to an entry in a bibliography. 

A) Footnote 

B) Citation 

C) Endnote 

Answer:  B 

Diff: 1 

Skill:  Word Chapter 2, various skills 

In Textbook:  Yes 


